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Introduction 

Purpose 
This Guide outlines the Selective Color Edit process for ICC device link 
editing using KODAK Custom Color Tools with KODAK APPROVAL 
PS, APPROVAL XP/XP4, and APPROVAL NX Proofing Systems. 
Using these procedures, you create and edit an ICC device link profile 
that is custom-designed for your site. You can then use the profile you 
created with the ICC-compatible color management capability of your 
front-end system. (A front-end system, typically associated with RIP 
software, processes image files before sending them to the proofing 
system.  Among front-end products used with the APPROVAL system 
are the Rampage system, Creo Brisque, Screen Trueflow, Nexus 
software, and other products.)  

What it does.  Custom Color Tools provides a color proofing system 
with the following: 

Fine-tuned color matching that exceeds the already excellent 
matching capability available with the Approval dot gain manager.  

Easy-to-use tools and techniques that allow the identification of 
specific color zones (such as neutrals, fleshtones, or reds) and 
adjustment of color balance solely within these zones.  

The high degree of selectivity of Custom Color Tools tools enables the 
same kind of precise color matching that would be available working 
directly with a set of color separations. Unlike the one-dimensional color 
adjustment capability of the dot gain manager, Custom Color Tools 
works with just those colors where fine-tuning is necessary. And, Custom 
Color Tools is a Photoshop plug-in module, making it an easy addition 
to your standard set of tools for color control.  

Read this Guide first. This Guide gives the specific recommendations 
and procedures that apply when using the ICC Professional Color 
Management Tools with the APPROVAL proofing system. Based on the 
information in this Guide, turn to the other specialized manuals provided 
with the system, particularly User’s Guide, Custom Color Tools, version 3.1.  

In addition, refer to documentation provided with Photoshop software 
for detailed information on the specific color adjustment tools 
recommended in this Guide. User documentation on using the ICC 
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Color Management capability of each type of front-end system is 
available from the front-end system supplier. 
Tools needed APPLE Macintosh workstation running OS X, with 

Adobe Photoshop software, version 7.x or 
Photoshop CS.   

ICC-compatible color management capability 
from the front-end system. 

Skills needed Photoshop know-how. Effective use of this tool 
requires capable handling of Photoshop software. 
This includes the ability to use tools within 
Photoshop that manipulate color space.  

Action tool. Because building color profiles requires 
that you selectively repeat color adjustments, 
familiarity with the Action tool in Photoshop 
software has particular value. 

Half-tone color knowledge. A reasonable degree of 
color expertise is needed to create ICC profiles and 
to use them effectively. 

Knowledge of front-end color management 
operation. 

What’s provided Custom Color Tools Software. This software 
installs from CD as a Photoshop plug-in. Follow 
instructions provided with the software.  

Color target file. The recommended color target is 
the familiar CALR target that is available from the 
installation CD. 

Guidelines for use Calibrate first. Before using this software, perform 
an initial calibration using the standard dot gain 
manager and density adjustment provided with the 
APPROVAL system.  

Effective use of this Custom Color Tools software 
requires that the standard APPROVAL calibration be 
correctly performed and that its results be evaluated 
over a range of proofs and over a period of time. 
Careful setup and assessment of the color 
performance of the proofing system in your 
environment helps to familiarize you with the overall 
capability and range of colors available and gives you 
time to clearly identify specific areas where color 
adjustment will be beneficial. Then, with specific 
color behavior in mind, you can proceed with the 
color adjustments described here to help to fine-tune 
the color match your digital proofing system 
provides.  
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Use only the Photoshop tools recommended 
here. Some of the color tuning utilities available in 
Photoshop software could cause unwanted effects 
for halftone color proofing. For example, some 
utilities might violate “dot fidelity” by adding process 
color dots where there are none in the original image 
data. Or, these utilities could incorrectly tint a process 
color solid. To avoid these problems (and preserve 
dot fidelity), use only the tools recommended in the 
procedures that follow. 

Recommendations 
for color tuning 

1. Color tuning is an iterative procedure, usually 
requiring several repetitions before satisfactory 
results are achieved. Expect to repeat this 
procedure a few times, but establish a reasonable 
limit for fine-tuning.  

2. Use the “No Color Management” ICC 
device profile.  Observe the requirement to 
begin with this “null” device link as a starting-
point with each iteration. Then, as instructed, 
repeat your color adjustments from previous 
sessions from this “null” base point (using the 
Actions feature of Photoshop software). 
Otherwise, rounding errors from each successive 
session can accumulate and frustrate your 
attempts to achieve fine-tuning (and degrade the 
quality of the device link).  

3. Color tuning is necessarily inexact. You 
cannot shift a single point in color space without 
affecting its neighbors, since colors must make 
reasonable transitions for natural appearance. To 
free the user from detailed involvement with the 
underlying mathematics of color theory, 
Photoshop applies algorithms that effectively 
“smooth” color transitions so that your edits 
shift colors uniformly. With this consideration, 
apply this tool where necessary and set limits on 
how much effort is worthwhile for achieving a 
perfect match. 

 
By default, the Custom Color Tools software installs an initial set of 
profiles in the default ICC profile directory or folder, depending on the 
version of Photoshop software and operating system.  For Macintosh 
OSX systems, this default folder is found in Library, ColorSync, 
Profiles.   
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Procedure  

Note: For the procedures that follow, a number of selectable parameters 
have more than one possible setting.  However, use only those 
settings indicated in this document when using the Custom Color 
Tools plug-in for the Approval XP/NX Digital Proofing system.   

Step 1: Launch Plug-in and Specify Profile and Reference Image 
1. Start Adobe Photoshop.  
Recommended: Before beginning a tuning session, quit Photoshop, 

then restart it. This helps to allocate sufficient memory for the 
procedures that follow.  

2. Make this main menu selection: 
File → Import → Custom Color Profile Edit… 

The Custom Color Import Plug-in window of Figure 1 displays. 

Figure 1.  Custom Color Import Plug-in 
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3. Under File Name, specify the No Color Management.icm 
profile. To select this entry, follow this procedure: 

• In the Profile Selection box, specify ICC Profile Type:  Device 
Link. 

• Click Choose… Then, from the window of Figure 2, highlight 
the No Color Management.icm entry and click Open to 
specify this file.  
 

Note: The No Color Management.icm profile gives a starting point, 
providing a “null” device profile that would perform no color 
management until edited. This start-point profile is installed in 
the default ICC Profiles folder or directory for the client 
workstation. 

4. From the plug-in window, in the Edit Transform box, make the 
selections shown in Figure 1.  The procedures that follow edit the 
Output Space component (the B component) of the Device Link 
profile.   

5. From the plug-in window, specify a Reference Image in the Image 
Selection box.  Use the Choose… button to browse for a 
Reference Image.   

Figure 2.  File Name Selection Window 
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The recommended reference image is the CALR image familiar to 
APPROVAL users. This image is installed in the folder named 
Reference Images with the application. Alternately, select another 
image used as a standard target at this site. (The target must be a 
TIFF image, CMYK color format. For display on the color monitor, 
72 dpi is sufficient. The recommended file is Calr72.tif, or some 
variant of this file.)  Highlight this file name and click Open.   

6. Click the upper radio button labeled Kodak Custom Color ICC 
Edit CMYK.   

7. From the plug-in window, click OK.   
In response, the reference image displays in Photoshop. The plug-in 
displays a strip of tracer pixels beneath the reference image, as is 
shown in Figure 3.  These pixels represent the full spectrum of 
available colors (and indicate that the reference image is loaded for 
use with the Custom Color Tools plug-in).  

 

Figure 3.  Reference Image Displayed for Color Tuning 

 
 

Tracer 
pixels 
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Step 2:  Start the Actions Utility 
Use the optional Actions utility as a convenient tool for saving your color 
edits, session to session.  The Actions utility automatically records all 
edits performed during a session that creates a Device Link.  Using this 
tool, it then becomes possible to replay editing steps as well as to alter, 
delete, or add edits.   

If you don’t want to use the Actions utility, separately record each color 
adjustment you make. Observe the recommendation to begin with a null 
settings and repeat successful adjustments each time.   

Use these steps to start this feature:  

1. Make this Photoshop main menu selection: 
Window → Actions 

The Actions palette of Figure 4 displays 

Figure 4.  Actions Palette 

 
 

By default, the Actions palette displays in list mode, as shown in Figure 4.  
(This is the preferred mode.)  Icons on the bottom of the Actions palette 
can be used to start or stop recording, to play an Action, and for other 
Actions management functions.  These functions are also available using 
the pull-down Actions palette menu.   

2. Disable Button mode.  
Do this from the pull-down Actions palette menu (see Figure 4).  
Verify that the Button mode menu entry is not checked.  

3. Start a New Action.  
To do this from the pull-down Actions palette menu, select New 
Action…  Optionally, click the icon indicated in Figure 4.   

In response, the window of Figure 5 displays.   

Toggle dialog 
On/Off 

Toggle item 
On/Off 

Click for 
Actions 
palette 
menu 

Click to 
create 
new 
Action 
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Figure 5.  Prompt for Creating New Action 

 
 

4. Name the Action and click Record.  
The Action window displays the new Action and lists the editing 
utilities used, as shown in Figure 6. The Action utility records these 
specific adjustments for later repetition.  

Note that each displayed Action has enabling toggle buttons on the left 
side of the Actions palette.  The item toggle enables or disables an Action 
for replay.  The dialog toggle enables the dialog window for the Action to 
display before executing the Action, requiring operator interaction (such 
as clicking the OK button) in order to continue.   

Recommended: There are a number of ways to use the Action tool. 
For help with overall approaches and strategies, see the User’s Guide, 
Custom Color Tools, version 3.1. 

 

Figure 6.  Display of New Action in Actions Palette 
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Step 3: Edit the Device Link Profile Using the Reference Image 
Note: The procedures that follow apply edits to the ICC device link 

profile, not to the reference image itself.  

The following steps include recommendations for the specific tools that 
are used for this purpose.  

Note: When used properly, Custom Color Tools create a device link 
profile that preserves dot fidelity, allowing subtle color changes to an 
existing setup for an image.  Use only the Photoshop color 
adjustment tools specified in this Step.  The tools specified here 
preserve dot fidelity for an image.  
Other Photoshop color adjustment tools may violate dot fidelity.  As a 
safeguard, this software checks and warns against any attempt to Export a 
device link in which dot fidelity is violated for a solid process color or solid 
overprint color (100% C,M,Y, or K, or combination of these).  You have the 
option to Cancel or Continue the Export operation.   

1. Identify  the colors to adjust.  For the best tool to identify colors to 
manipulate, use the following main menu selection: 
Select --> Color Range… 

Figure 7 shows the Color Range selection window, with 
recommended settings.   

This tool allows you to point to areas on the color target where color 
adjustment is necessary.  

Figure 7.  Color Range Selection 
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Hints 
Hints for using the Color Range selection tool include the following: 

• Use the Fuzziness adjustment for identifying the relative size of 
the area in color space that is of interest. 

• Use the eyedropper tool to specify a color. 
• Use the “+” eyedropper tool to add an additional color to those 

already selected. 
• Use the Load… or Save… functions to load or save color range 

selections for use with results of other color editing sessions.  
• Use the menu selection View  Extras to eliminate pixel traces, 

if distracting.   
Click OK to enable the selected colors.  Areas using these colors are 
then outlined as is shown in Figure 8. 

Figure 8.  Color Range Selection Enabled 

 
Note that the Actions palette displays the results of this color selection 
step, as shown in the example of Figure 9.  
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Figure 9.  Action Palette Display for Color Range Selection 

 
 

2. Adjust the color as necessary. The best tool for this purpose is 
available using the following main menu selection, as shown in 
Figure 10: 
Image → Adjustments → Color Balance... 

Figure 10.  Making Color Balance Menu Selection 

 
 

In response, the Color Balance entry window of Figure 11 displays.  

Figure 11. Color Balance Window 
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Use settings in the Color Balance window as follows: 

Tone Balance.  Specify a range for color balance adjustment by 
clicking the appropriate button labeled Shadows, Midtones, or 
Highlights.   

Color Levels.  Use the slide bar controls to manipulate the color 
levels for Cyan, Magenta, and Yellow.  

Preserve Luminosity.  When checked, automatically adjusts all 
color channels in response to a change in a single color channel.  
When unchecked, changes are constrained to the single color 
channel itself.  

View the effects of these changes on the reference image.  Edits also 
apply to the tracer pixels area (but may be difficult to detect on this 
portion of the display).  Use the Preview toggle to compare your 
modified version with the original.   

Note that the Actions palette shows results of color balance editing, 
as in the example of Figure 12.   

Notes for Color Balance Editing 
These general notes apply for using the Color Balance editing tools most 
effectively: 

Limit the number of individual edits to specific color areas.  A 
smaller number of general edits is easier to manage. 

At the completion of color editing, de-select the color range using 
Select Deselect.  Then, repeat procedures given in 1 and 2 of 
Step 3 for the new edits. 

 

Figure 12.  Actions Palette for Color Balance Adjustments 

 
 

Another useful tool for monitoring color values during color tuning is 
the Photoshop information tool of Figure 13. To display its window, 
select Window from the main menu.  Check Info. 
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Figure 13  Information Tool Window 

 
 

Depending on the operation being performed, this window shows 
current values or before/after values for the selected color area.   

 

Step 4: Stop Actions 
Once your edits are complete, make this selection from the Action 
window of Figure 4.   

Stop Recording 

With this command, the Actions (started and named in STEP 2 above) 
are preserved and ready for your next tuning session with this image.  
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Step 5: Export The Tuned Device Link Profile 
1. Make this main menu selection: 

File → Export → Custom Color Profile Export...  

In response, the window of Figure 14 displays.   

Figure 14.  Export Information and Prompt Window 

 
 

2. Review the displayed information.  If acceptable, click OK.   
In response, the prompt of Figure 15 displays. 

Figure 15.  Profile Description Entry Window 

 
 

3. Enter a description for the profile.   
Recommended: Use the same text for description in this step and 

file name in the step that follows.  The description displays when 
selecting a profile.   

The prompt of Figure 16 displays. 
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Figure 16.  File Name Prompt Window 

 
 

4. Enter a filename following the Save As:  prompt.  Then click Save. 
 

Recommended: Save the Actions with the profile.  

Recommended: Use a description and naming convention that 
allows easy identification and matching of both files. This will prove 
to be especially handy for troubleshooting problems with color 
matching or with the proofing system.  

 

Step 6: Apply The Device Link To A Proof 
This step applies the new ICC device link profile you created to a 
proofed image.  

1. Move the ICC device link to the RIP.  
2. Follow front end RIP procedure to install and enable the ICC device 

link on the front end. 
3. Make a new proof with the ICC device link enabled.  
4. Assess the color match achieved.  
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Repeating the Color Tuning Procedure 
Typically, color tuning requires a few iterations of the color tuning 
performed in Steps 1–6 given above. For best results, do not attempt to 
further tune the profile generated and saved using the above 
procedure. Instead, use this sequence: 

1.  Always start the procedure with a “null” device link (the “No Color 
Management” selection in Step 1).  

2.  Edit individual steps in the Action to modify color settings.  
(Optionally, you can review steps for an earlier Action on-screen as you 
perform edits saved as a new Action.) 

3.   Repeat the edit sequence recorded earlier using the Actions feature.  

This strategy helps to prevent “rounding” errors that can occur when 
complex transforms being executed by the Photoshop software adjust 
the numerous color space coordinates that are affected by even simple 
color shifts. (As a side benefit, this method also helps to prevent clutter 
from storing numerous interim versions of device link files.)  

Strategy for achieving a closer match: 
1. Start with “No Color Management” each time. (This provides a null 

device link as a starting-point.)  
2. Use the Actions tool to record and replay successful edits.  

Then, do additional editing after applying these saved Actions.  

Notes 


